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Welcome to OpenBook 
OpenBook is a software program that transforms your 
personal computer and scanner into a full-featured reading 
machine. Use any of today’s popular scanners or the 
PEARL® Portable Reading Camera from Freedom Scientific, 
to acquire the text of your favorite magazine, book, or 
newspaper article, and let OpenBook immediately read that 
page aloud to you. Or open an electronic file from any of 
today’s most popular applications and edit at will. With 
OpenBook nothing is left inaccessible and even better, you 
are in control of how a page is read and presented on your 
computer screen. 

With PEARL, you will experience instantaneous page 
acquisition, enabling OpenBook to process multiple pages 
within seconds. The PEARL camera has an automatic mode 
that senses motion and allows it to capture an image 
whenever a page is turned. When used on a laptop or 
notebook computer, you will have a truly portable acquisition 
and reading system while on the go.  

System Requirements 
The recommended system requirements for OpenBook are 
listed below.  

 

Specification Minimum Requirement 

Operating system All 32- and 64-bit versions of 
Windows 8, Windows 7, Windows 
Server 2008, Windows Vista, and 
32-bit versions of Windows XP 
and Windows Server 2003. 

Processor speed 500 MHz Intel® Pentium® or 
faster 
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Specification Minimum Requirement 

Memory (RAM) 256 MB (512 MB recommended) 

Available hard disk 
space  
for installation 

1.2 GB (on the drive containing 
the Program Files and Windows 
folders) 

Video 256 color graphics 

Sound Windows compatible sound card 
and speakers 

Keyboard 104 key Keyboard 

Acquisition device A TWAIN or WIA-compatible 
flatbed scanner or the PEARL 
from Freedom Scientific 

CD ROM Drive  

Installing OpenBook 
To install OpenBook on your computer, do the following: 

Important:   
If you will be using the PEARL, do not connect the 
camera to your computer until the OpenBook installation 
is complete. For more information on connecting and 
setting up PEARL, refer to the PEARL Quick Start 
Guide. 

1. Insert the OpenBook disc into your CD-ROM drive. 

2. The OpenBook Setup program starts. You will hear the 
installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note:  If your OpenBook installation disc does not start 
automatically, go to the Start button, select Run, and 
type D:\setup. If your CD-ROM drive is not D, 
substitute the correct drive letter. 
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The OpenBook setup program will then begin. 

3. Choose the Typical installation to install OpenBook to 
the default location on your hard drive. Select the 
Custom installation if you want to install OpenBook in a 
location other than the default.  

4. Once installation is complete, you must restart your 
computer before using OpenBook. 

Note:  During installation on certain Windows systems, you 
may receive a message stating that software you are 
installing has not passed Windows Logo testing to verify 
its compatibility with Windows. If this occurs, choose the 
Continue button in Windows XP or Vista, or the Yes 
button in Windows 7 to ignore this message and resume 
the installation. OpenBook will install and run correctly. 

Uninstalling OpenBook  
To uninstall OpenBook go to the Programs Menu and select 
OpenBook 9.0. In the Tools submenu select the Uninstall 
OpenBook option and follow the prompts to remove the 
software. If you have any other Freedom Scientific products 
such as JAWS or MAGic installed, make sure you choose the 
option to leave shared components. 

Activating OpenBook 
After you install OpenBook, you must activate your software. 
When you first start OpenBook, you are asked to activate the 
program. You can activate OpenBook at a later time by 
opening the Help menu and choosing Update Authorization. 
OpenBook runs in 40 minute mode until it is activated on your 
computer. To close the Activation dialog box and continue 
using OpenBook in 40 minute mode, choose Run as Demo. 
You must restart your computer every 40 minutes in order to 
continue using OpenBook until it is activated. 
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Internet License Manager (ILM) allows you to quickly activate 
OpenBook using the Internet. If you do not have an Internet 
connection, you can activate OpenBook by telephone or fax. 
Alternatively, you can activate OpenBook with the assistance 
of a trusted friend, relative, or organization that has access to 
the Internet.  

Note:  Your user account must have power user or 
administrator privileges to activate OpenBook. Contact 
your network administrator if your account does not have 
the required level of access. 

You can also use a dongle (a hardware device that connects 
to your computer's USB or parallel port) to make your 
OpenBook license more portable. A dongle allows you to use 
an authorized version of OpenBook on any computer as long 
as the dongle remains connected. 

Note:  Adding or removing certain hardware components may 
cause your computer's Locking Code to change. If this 
occurs, you must reactivate OpenBook. If you need to 
request more activations, go to 
http://www.fsactivate.com. 

Activating with Internet License Manager 

You can use Internet License Manager (ILM) to activate 
OpenBook using an Internet connection. This is the easiest 
and quickest way to activate your product. To activate 
OpenBook using the Internet, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-ROM 
drive and choose Activate Using Authorization CD. You 
can find your Authorization CD in the same sleeve as your 
OpenBook program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization 
Number Manually. 
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Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Now, Using the Internet 
(RECOMMENDED), and then press ENTER.  

5. If you used your Authorization CD, your 20-digit 
Authorization number is automatically inserted into the 
Authorization Number edit box. If your Authorization 
number is not shown, type it into the edit box. You can find 
your Authorization number in print and Braille on your 
OpenBook disc sleeve.  

6. Press ENTER to continue. You will be asked to connect to 
the Internet if you have not already done so. You must 
establish an Internet connection before continuing with the 
activation.  

7. If you have not registered OpenBook, you are asked to do 
so now. Registering OpenBook lets you receive technical 
support. Choose Register Now and complete the online 
registration form by following the instructions provided. 
You can choose to register later, but you must register the 
next time you activate OpenBook.  

8. After you submit your registration, Internet License 
Manager attempts to activate OpenBook. This process 
may take several minutes. When the activation is 
successful, choose Finish. 

Note:  If Internet License Manager cannot activate OpenBook 
because of your firewall software, see the next section, 
Troubleshooting Firewall Software. 

Troubleshooting Firewall Software 

Firewalls protect computer systems from being accessed by 
unauthorized users. Some network or personal firewall 
software may interfere with the installation, activation, or 
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usage of OpenBook. The following information will help you 
reconfigure your firewall to work with OpenBook. Refer to 
your firewall software documentation for more information on 
allowing access for programs and files. 

Note:  Hardware firewalls do not interfere with installing, 
activating, or running OpenBook. 

Firewall Interferes with Installation 

If your firewall software is preventing you from installing 
OpenBook on your computer, reconfigure the firewall to allow 
the file Setup.exe to run. Then retry the installation procedure. 

Firewall Interferes with Activation 

If your firewall software prevents you from activating 
OpenBook using the Internet, reconfigure the firewall to allow 
the following files to run: FSActivate.exe, CAUtil.exe, and 
CAUtil.enu. Once you have reconfigured your firewall, retry 
the activation process. If you cannot reconfigure the firewall, 
or if you still cannot activate OpenBook, go to 
www.FSActivate.com. Follow the instructions on the Web 
page to retrieve an Activation License code and activate your 
software. For more information on using 
www.FSActivate.com, see Activating through a Trusted Third 
Party. 

Firewall Interferes with Using OpenBook 

If the firewall software prevents OpenBook from running or 
starting, or displays a warning message, reconfigure the 
firewall to allow the file OBU.exe to run. 

Activating by Telephone 

If you do not have an Internet connection, you can call 
Freedom Scientific Customer Service. Customer Service will 
send you a CD in the mail that will automatically activate 
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OpenBook. To activate OpenBook by telephone, do the 
following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-ROM 
drive and choose Activate Using Authorization CD. You 
can find your Authorization CD in the same sleeve as your 
OpenBook program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization 
Number Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Telephone to Receive 
Activation by Mail, and then press ENTER.  

5. Call (727) 803-8015. Provide the customer service 
representative with the Authorization number and Locking 
code shown in this dialog box. If your Authorization 
number is not shown, you can find it in print and Braille on 
your OpenBook disc sleeve. 

6. Choose Quit. You can continue using OpenBook in 40 
minute mode until you receive your CD. 

When you receive the CD with your Activation License code 
from Freedom Scientific, insert it into your CD-ROM drive to 
automatically activate OpenBook. 

Note:  If the CD does not automatically activate your software, 
press WINDOWS Key+R, type 
"D:\ActivationCode.exe" and press ENTER. If 
your CD-ROM drive is not D:, then substitute the correct 
letter. 
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Activating by Fax 

If you do not have an Internet connection, you can send a fax 
to Freedom Scientific with your Authorization number and 
Locking code. You will then receive an Activation License 
code either in an e-mail message or on a CD. To activate 
OpenBook by fax, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-ROM 
drive and choose Activate Using Authorization CD. You 
can find your Authorization CD in the same sleeve as your 
OpenBook program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization 
Number Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Fax, and then press 
ENTER.  

5. Complete the form by typing the required information into 
the edit boxes. If you want to receive your Activation 
License code in an e-mail message, enter your e-mail 
address. If you do not enter an e-mail address, Freedom 
Scientific will send you a CD in the mail that will 
automatically activate OpenBook. 

6. If you used your Authorization CD, your 20-digit 
Authorization number is automatically inserted into the 
Authorization Number edit box. If your Authorization 
number is not shown, type it into the edit box. You can find 
your Authorization number in print and Braille on your 
OpenBook disc sleeve. 
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7. Choose Print to send the form to your printer. After you 
have printed the form, choose Quit. 

8. Fax the printed form to (727) 803-8001. 

If you entered your e-mail address, you should receive an e-
mail message from Freedom Scientific within one or two 
business days. Follow the instructions provided in the 
message to activate OpenBook. If you do not enter an e-mail 
address, you will receive a CD from Freedom Scientific in the 
mail. Insert the CD into your CD-ROM drive to automatically 
activate OpenBook. 

Note:  If the CD does not automatically activate your software, 
press WINDOWS Key+R, type 
"D:\ActivationCode.exe" and press ENTER. If 
your CD-ROM drive is not D:, then substitute the correct 
letter. 

Activating through a Trusted Third Party 

If you know a friend, relative, or other trusted person with an 
Internet connection, they can help you activate OpenBook. 
Alternatively, you can use an Internet connection in a library, 
at work, or anywhere else. You or a trusted third party can 
visit http://www.FSActivate.com to obtain your Activation 
License code.  

To obtain an Activation License code from FSActivate.com, 
do the following: 

1. Point your Web browser to http://www.FSActivate.com. 

2. Enter your 20-digit Authorization number and Locking 
code. Your Authorization number appears on your 
OpenBook disc sleeve in both print and Braille. To find 
your computer's Locking code, open the OpenBook Help 
menu and choose About OpenBook. 

Note:  The Locking code is unique for each individual 
computer. Be sure you enter the Locking code of the 
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computer you intend to use with OpenBook when it is 
activated. 

3. Choose Submit License Request to receive an Activation 
License code.  

4. The remaining steps must be completed on the computer 
where the copy of OpenBook you want to activate is 
installed. Begin by starting OpenBook on this computer. 
From the OpenBook Help menu, choose Update 
Authorization.  

5. In the Activation dialog box, choose Start Activation.  

6. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-ROM 
drive and choose Activate Using Authorization CD. You 
can find your Authorization CD in the same sleeve as your 
OpenBook program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization 
Number Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
7 of the activation. 

7. Choose Activate.  

8. Use the ARROW keys to select the Activation Generated 
from www.FSActivate.com radio button and press ENTER.  

9. Type the Activation License code you received from 
www.FSActivate.com into the edit box and then press 
ENTER.  

10. After you have successfully activated OpenBook, choose 
Finish to complete the process. 

Dongle Authorization 

A dongle is a hardware device that you can connect to a 
computer's parallel or USB port (depending on the type of 
dongle). OpenBook is authorized to run on that computer as 
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long as the dongle remains connected. This is useful if you 
frequently need to use OpenBook on many different 
computers and do not want to activate the program on each 
of them.  

When OpenBook starts, it first determines whether a dongle 
is connected to the computer. If one is connected, 
OpenBook uses the features and information for the license 
associated with the dongle to authorize OpenBook. If no 
dongle is connected, OpenBook searches for the license 
information stored on the computer. You can use the Dongle 
Viewer utility to view information on the license associated 
with the dongle currently connected to your computer. To 
start this utility, go to the OpenBook 9.0 program group, 
open the Tools submenu, and choose Dongle Viewer. 

Note:  It is recommended that you do not connect the dongle to 
your computer until after you install OpenBook. If the 
dongle was connected before or during installation, you 
must restart your computer to receive proper 
authorization. 

Dongles are sold separately or as an additional OpenBook 
feature. Contact Freedom Scientific Sales at 800-444-4443 
or 727-803-8000 if you want to purchase one.  

Note:  Certain international versions of OpenBook require a 
dongle for authorization. Using one of these versions 
without a dongle displays an error message. 

Installing the RealSpeak Solo Direct 
Synthesizer 

Included with the OpenBook program disc is another disc 
containing the RealSpeak™ Solo Direct speech synthesizer. 
It contains a variety of voices in several languages. To install 
these voices, insert the disc into your computer's CD-ROM 
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drive. Next, follow the instructions to select which voices you 
want to install, and complete the installation.  

You can also use the RealSpeak Solo Direct Sample and 
Download page available at 
http://www.freedomscientific.com/downloads/RealSpeak-
Solo-Direct-Voices/RealSpeak-Solo-Direct-Downloads.asp. 
On this page, you can preview voice samples, and then 
download and install voices directly from the Web page. 

Getting Started 

Launching OpenBook 

OpenBook gives you a variety of ways to launch the program.  

 Press the hot key, ALT+CTRL+O, which is automatically 
assigned when you install OpenBook. If this hot key 
does not launch OpenBook after it has been installed, 
you must restart your computer in order for this 
keystroke to work correctly. 

 Using your mouse, double-click the OpenBook 9.0 icon 
on your desktop.  

 Go to the Start menu and select Programs. Select the 
OpenBook 9.0 program group and choose OpenBook 
9.0.  

Once launched, OpenBook opens with a blank untitled 
document from which you can begin working and announces 
whether the document is in Read-only or Edit Mode. If you 
prefer, you can change the startup document to be the 
document you were working on last. To do this, go to the 
Settings Menu and select General Settings (ALT+G, G). In 
the General Settings Dialog box, press TAB until you arrive 
on the Open Untitled Document on Startup radio button. 
Press the DOWN ARROW key to select the Open Last 
Document on Startup radio button. If you want to make more 
setting changes, press ALT+A or TAB to the Apply button 
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and press the SPACEBAR. Exit this properties page by 
pressing ENTER. Next, to change the settings so that 
OpenBook is always in this Mode, open the Settings Menu 
again (ALT+G). From the Menu, choose Save the Settings... . 
In the Save Settings dialog box, press ENTER to make the 
changes part of the default settings. For more information on 
this feature, please see the book, Using Settings Files. 

Closing OpenBook  

You can close OpenBook like any other Windows application 
by pressing ALT+F4, pointing the mouse and left clicking on 
the X in the top right hand corner of the window, or selecting 
Exit from the File menu.  

Acquiring and Reading 
OpenBook combines the best in image acquisition, image 
processing, and reading features to convert printed media 
into electronic format. It then displays and reads the content 
aloud giving you access to material that would otherwise be 
inaccessible or difficult to read.  

When you install OpenBook, the Eloquence text-to-speech 
synthesizer from Nuance is also installed and is the default 
for reading. OpenBook can acquire images using either a 
scanner, or the PEARL camera. You can acquire one or more 
pages from a document, such as a book or piece of mail, and 
then read or edit the resulting text. If you want to keep the 
document you just acquired, you can then save it to a file on 
your computer. Additionally, you can customize the 
acquisition, processing, reading, and display properties of 
OpenBook. 

To acquire a page from a scanner, place the page on the 
scanner bed and press the F4 key when you are ready to 
acquire the page. 
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To acquire a document from the PEARL, position the page 
under the camera so that the top edge is aligned with the 
page guide. Center the page between the outer edges of the 
page guide, or line up a side edge of the document with an 
outer edge of the page guide. Press the F4 key when you are 
ready to begin acquiring. 

Note:  The PEARL is optimized to work in normal room lighting 
under most conditions. The LED should be left off. 

Here are a few shortcut keys to get you started with 
OpenBook.  

 To have OpenBook read to you, press INSERT+DOWN 
ARROW.  

 To acquire a page, press F4 or SPACEBAR.  

 To toggle between Edit Mode and Read-only Mode, 
press CTRL+E. 

 To silence speech press the CTRL key. 

 To read faster, press ALT+CTRL+PAGE UP. 

 To read slower, press ALT+CTRL+PAGE DOWN. 

Getting Help 

Context-Sensitive Help 

When you are in a dialog box, press SHIFT+F1 to read the 
context-sensitive help message for the current item.  

You can also access context-sensitive help by right clicking 
the mouse on a control and selecting “What’s This” or by 
clicking on the ? (question mark) symbol at the top right 
corner of the dialog box and then clicking on a control. 

Key Describer 

Turning on Key Describer allows you to safely explore 
keyboard commands without actually performing the 
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command. For example, when you turn on Key Describer and 
press a key, OpenBook tells you what the selected key does 
without actually performing that particular function. To turn on 
Key Describer, press INSERT+1. Press INSERT+1 again to 
turn off Key Describer and return to normal operation.  

OpenBook User’s Guide 

We provide you with the content of the OpenBook Online 
Help System in the OpenBook User’s Guide, which uses 
large text for easy reading. The manual contains the Quick 
Start Guide, a detailed description of OpenBook’s features, 
and pull out reference cards. 

Technical Support 

If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 AM to 7:00 
PM Eastern Standard Time. 

Please have the following information on hand: 

 Product serial number used for registration. 

 Product name and version number. 

 Type of computer hardware you are using. 

 Software version number of Windows. 

About OpenBook 

Select About OpenBook from the Help menu to view the 
version number of OpenBook you are currently running. This 
dialog box also displays your product serial number and your 
computer’s locking code (used for ILM activation). 
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Updating OpenBook 
Freedom Scientific is continually seeking to improve and 
expand OpenBook. Periodically, updates to OpenBook will be 
released. It is recommended that you keep your software up-
to-date so that you experience the greatest possible 
performance.  

Updating your software is quick and easy. To search for 
updates to OpenBook, do the following: 

Note:  Your computer must be running Windows XP or later, 
and it must be able to access the Internet in order to use 
the following update procedure. 

1. Press ALT+H or click on the Help menu. 

2. Press P or select Check for Updates. The update feature 
determines if you have the most current release. If you do 
not, select one or more items from the list and then select 
INSTALL to begin the update. All enhancements since the 
initial release are included in the update.  

Note:  If your computer has active firewall software (such as 
Windows Firewall), you may receive a warning indicating 
that either the FSAutoUpdate Application or 
FSAutoUpdate.exe is attempting to access the Internet. 
You must allow this process to access the Internet 
through the firewall in order to retrieve updates. 
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Desktop Keyboard Layout 

Reading 
Description Keystroke 

Number Announcement 
Toggle 

CTRL+SHIFT+N 

Read Dialog Box in Tab 
Order 

INSERT+B 

Read Default Button of 
Dialog Box 

INSERT+E 

Read Current Dialog Box 
Control 

INSERT+TAB 

Say Character NUM PAD 5 

Say Word INSERT+NUM PAD 5 

Spell Word INSERT+NUM PAD 5 twice 
quickly 

Spell Word Phonetically INSERT+NUM PAD 5 three 
times quickly 

Say Line INSERT+UP ARROW 

Say Sentence ALT+NUM PAD 5 

Say Paragraph CTRL+NUM PAD 5 

Say To Cursor INSERT+HOME 

Say From Cursor INSERT+PAGE UP 

Say Top Line of Window INSERT+END 

Read Status Bar INSERT+PAGE DOWN 



18 

Description Keystroke 

Say Window Title INSERT+T 

Say All INSERT+DOWN ARROW 

Skim Read CTRL+INSERT+DOWN 
ARROW 

Fast Forward/Rewind (during 
Say All or skimming) 

LEFT/RIGHT ARROW or 
LEFT SHIFT/RIGHT SHIFT 

Silence Speech CTRL 

Audio File Navigation 
Description Keystroke 

Start/Stop Audio Playback INSERT+DOWN ARROW 

Pause Playback CTRL 

Move to the Next Heading or 
Audio File 

DOWN ARROW 

Move to the Previous 
Heading or Audio File 

UP ARROW 

Expand a subheading (in 
DAISY files only) 

RIGHT ARROW 

Close a subheading (in 
DAISY files only) 

LEFT ARROW 

Say Current Heading or 
Audio File 

INSERT+NUM PAD 5 

Move to the First Heading or 
Audio File 

CTRL+HOME 

Move to the Last Heading or 
Audio File 

CTRL+END 
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Description Keystroke 

Fast Forward Five Seconds RIGHT ARROW or RIGHT 
SHIFT 

Rewind Five Seconds LEFT ARROW or LEFT 
SHIFT 

Increase Playback Rate for 
DAISY Audio Files 

ALT+CTRL+PAGE UP 

Decrease Playback rate for 
DAISY Audio Files 

ALT+CTRL+PAGE DOWN 

Document Navigation 
Description Keystroke 

Back Space BACKSPACE 

Go To Bookmark F9 

Open Go To Dialog CTRL+G 

Go To Next item (page, 
comment, or highlight) as 
specified in Go To dialog 

F5 

Go To Prior item (page, 
comment, or highlight) as 
specified in Go To dialog 

SHIFT+F5 

Next Character (Edit Mode) RIGHT ARROW (moves by 
word in Read-only mode) 

Prior Character (Edit Mode) LEFT ARROW (moves by 
word in Read-only mode) 
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Description Keystroke 

Next Word CTRL+RIGHT ARROW, 
INSERT+RIGHT ARROW, or 
RIGHT ARROW when in 
Read-only Mode 

Prior Word CTRL+LEFT ARROW, 
INSERT+LEFT ARROW, or 
LEFT ARROW when in Read-
Only Mode 

Next Line DOWN ARROW 

Prior Line UP ARROW 

Next Sentence ALT+DOWN ARROW 

Prior Sentence ALT+UP ARROW 

Next Paragraph CTRL+DOWN ARROW 

Prior Paragraph CTRL+UP ARROW 

Next Page CTRL+PAGE DOWN 

Prior Page CTRL+PAGE UP 

Page Down PAGE DOWN 

Page Up PAGE UP 

End of File CTRL+END 

Top of File CTRL+HOME 

Help 
Description Keystroke 

Context Sensitive Help SHIFT+F1 

Help F1 
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Description Keystroke 

Keyboard Help INSERT+1 

Where Am I CTRL+SHIFT+F12 

Text Selection 
Description Keystroke 

Select Next Character (Edit 
Mode) 

SHIFT+RIGHT ARROW 

Select Prior Character (Edit 
Mode) 

SHIFT+LEFT ARROW 

Select Next Word CTRL+SHIFT+RIGHT 
ARROW, 
INSERT+SHIFT+RIGHT 
ARROW, or SHIFT+RIGHT 
ARROW in Read-only Mode 

Select Prior Word CTRL+SHIFT+LEFT ARROW, 
INSERT+SHIFT+LEFT 
ARROW, or SHIFT+LEFT 
ARROW in Read-only Mode 

Select Next Line SHIFT+DOWN ARROW 

Select Prior Line SHIFT+UP ARROW 

Select to End of Line SHIFT+END 

Select to Beginning of Line SHIFT+HOME 

Select Next Page SHIFT+PAGE DOWN 

Select Prior Page SHIFT+PAGE UP 

Select to Beginning of Page CTRL+SHIFT+HOME 

Select to End of Page CTRL+SHIFT+END 
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Description Keystroke 

Select All text on current 
page 

CTRL+A 

Say Selected Text INSERT+SHIFT+DOWN 
ARROW 

Acquisition 
Description Keystroke 

Toggle Recognize Columns CTRL+SHIFT+Z 

Acquire F4 or SPACEBAR when 

Mail Sorter Preview CTRL+SHIFT+F3 

Acquire and Replace Current 
Page 

CTRL+SHIFT+F4 

BuckScan money identifier CTRL+M 

Acquisition Context Menu APPLICATIONS Key 

Visual Settings 
Description Keystroke 

Cycle Between Views CTRL+SHIFT+V 

Font Background Color CTRL+5 

Font Size – Increase CTRL+4 

Font Size – Decrease CTRL+3 

Font Spacing – Increase CTRL+8 

Font Spacing – Decrease CTRL+7 

Font Type CTRL+6 

Toggle Two Tone CTRL+2 
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Description Keystroke 

Scroll Exact View Down ALT+CTRL+DOWN ARROW 

Scroll Exact View Left ALT+CTRL+LEFT ARROW 

Scroll Exact View Right ALT+CTRL+RIGHT ARROW 

Scroll Exact View Up ALT+CTRL+UP ARROW 

Pan Down Incrementally CTRL+WINDOWS 
Key+DOWN ARROW 

Pan Up Incrementally CTRL+WINDOWS Key+UP 
ARROW 

Pan Left Incrementally CTRL+WINDOWS Key+LEFT 
ARROW 

Pan Right Incrementally CTRL+WINDOWS 
Key+RIGHT ARROW 

Pan Up One Screen PAGE UP 

Pan DOWN One Screen PAGE DOWN 

Pan to Top Left WINDOWS Key+HOME 

Pan to Top RIGHT WINDOWS Key+PAGE UP 

Pan to Bottom Left WINDOWS Key+PAGE 
DOWN 

Pan to Bottom Right WINDOWS Key+END 

Pan Down Smoothly WINDOWS Key+DOWN 
ARROW 

Pan Up Smoothly WINDOWS Key+UP ARROW 

Pan Left Smoothly WINDOWS Key+LEFT 
ARROW 
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Description Keystroke 

Pan Right Smoothly WINDOWS Key+RIGHT 
ARROW 

Increase Smooth Panning 
Speed 

PLUS 

Decrease Smooth Panning 
Speed 

MINUS 

Increase Zoom Level CTRL+PLUS (press and hold 
to zoom continuously until you 
reach the desired zoom level) 

Decrease Zoom Level CTRL+MINUS (press and hold 
continuously until you reach 
the desired zoom level) 

Zoom to Page Width CTRL+SHIFT+W 

Zoom to Page Height CTRL+SHIFT+H 

Zoom to Default Zoom Level CTRL+SHIFT+D 

Rotate Image Right CTRL+SHIFT+R 

Rotate Image Left CTRL+SHIFT+L 

Toggle Camera Light CTRL+L 

OpenBook Feature Hotkeys 

Description Keystroke 

Insert Bookmark CTRL+F9 

Delete Bookmark CTRL+SHIFT+F9 

Insert Comment ALT+CTRL+M 

Delete Comment SHIFT+DELETE 
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Description Keystroke 

Edit Comment ALT+ENTER 

Say Comment ALT+SHIFT+APOSTROPHE 

Begin/end Highlight CTRL+F11 

Highlight Selected Text ALT+F11 

Cancel Highlight ESC 

Remove Highlight CTRL+SHIFT+F11 

Say Highlight ALT+CTRL+F11 

Toggle Highlight 
Announcement 

ALT+SHIFT+F11 

Next  Highlight F11 

Prior Highlight SHIFT+F11 

Copy to Clipboard CTRL+C 

Cut to Clipboard (Edit 
mode) 

CTRL+X 

Paste from Clipboard (Edit 
mode) 

CTRL+V 

Delete Current Page CTRL+DELETE 

Delete Character (Edit 
Mode) 

DELETE 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle 

CTRL+E 

Move Page Down in page 
order 

ALT+PAGE DOWN 
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Description Keystroke 

Move Page Up in page 
order 

ALT+PAGE UP 

Insert Page Break (Edit 
Mode) 

CTRL+ENTER 

Delete Page Break (Edit 
Mode) 

CTRL+SHIFT+DELETE 

Find text CTRL+F 

Find next occurrence of text CTRL+SHIFT+F 

Replace text (Edit Mode) CTRL+H 

Spell Check F7 

Thesaurus CTRL+T 

Undo CTRL+Z 

Decrease Voice Rate ALT+CTRL+PAGE DOWN 

Increase Voice Rate ALT+CTRL+PAGE UP 

Mute Synthesizer CTRL+F5 

Close Document Window CTRL+F4 

Document Toggle CTRL+F6 

New File CTRL+N 

Open File CTRL+O 

Open Audio Directory CTRL+R 

Print CTRL+P 

Save Current Page CTRL+SHIFT+S 

Save Document CTRL+S 
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Description Keystroke 

Exit OpenBook ALT+F4 
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Laptop Keyboard Layout 

Reading 
Description Keystroke 

Number Announcement 
Toggle 

CTRL+SHIFT+N 

Read Dialog Box in Tab 
Order 

INSERT+B 

Read Default Button of 
Dialog Box 

CAPSLOCK+E 

Read Current Dialog Box 
Control 

CAPSLOCK+TAB 

Say Character CAPSLOCK+COMMA 

Say Word CAPSLOCK+K 

Spell Word CAPSLOCK+K twice quickly 

Spell Word Phonetically CAPSLOCK+K three times 
quickly 

Say Line CAPSLOCK+UP ARROW or 
CAPSLOCK+I 

Say Sentence CAPSLOCK+H 

Say Paragraph CAPSLOCK+CTRL+I 

Say To Cursor CAPSLOCK+SHIFT+J 

Say From Cursor CAPSLOCK+PAGE UP or 
CAPSLOCK+SHIFT+L 

Say Top Line of Window CAPSLOCK+END or 
CAPSLOCK+SHIFT+Y 
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Description Keystroke 

Read Status Bar CAPSLOCK+SHIFT+N 

Say Window Title CAPSLOCK+T 

Say All CAPSLOCK+DOWN ARROW 
or CAPSLOCK+A 

Skim Read CTRL+INSERT+DOWN 
ARROW 

Fast Forward/Rewind (during 
Say All or skimming)  

LEFT/RIGHT ARROW or 
LEFT SHIFT/RIGHT SHIFT 

Silence Speech  CTRL 

Audio File Navigation 
Description Keystroke 

Start/Stop Audio Playback INSERT+DOWN ARROW 

Pause Playback CTRL 

Move to the Next Heading or 
Audio File 

DOWN ARROW 

Move to the Previous 
Heading or Audio File 

UP ARROW 

Expand a subheading (in 
DAISY files only) 

RIGHT ARROW 

Close a subheading (in 
DAISY files only) 

LEFT ARROW 

Say Current Heading or 
Audio File 

CAPSLOCK+K 

Move to the First Heading or 
Audio File 

CTRL+HOME 
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Description Keystroke 

Move to the Last Heading or 
Audio File 

CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or RIGHT 
SHIFT 

Rewind Five Seconds LEFT ARROW or LEFT 
SHIFT 

Increase Playback Rate for 
DAISY Audio Files 

ALT+CTRL+PAGE UP 

Decrease Playback rate for 
DAISY Audio Files 

ALT+CTRL+PAGE DOWN 

Document Navigation 
Description Keystroke 

Back Space BACKSPACE 

Go To Bookmark F9 

Open Go To Dialog CTRL+G 

Go To Next item (page, 
comment, or highlight) as 
specified in Go To dialog 

F5 

Go To Prior item (page, 
comment, or highlight) as 
specified in Go To dialog 

SHIFT+F5 

Next Character (Edit Mode) RIGHT ARROW or 
CAPSLOCK+PERIOD (moves 
by word in Read-only Mode)  
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Description Keystroke 

Prior Character (Edit Mode) LEFT ARROW or 
CAPSLOCK+M (moves by 
word in Read-only Mode) 

Next Word CTRL+RIGHT ARROW, 
INSERT+RIGHT ARROW, or 
RIGHT ARROW when in 
Read-only Mode 

Prior Word CTRL+LEFT ARROW,

Next Line DOWN ARROW or 
CAPSLOCK+O 

Prior Line UP ARROW or 
CAPSLOCK+U 

Next Sentence ALT+DOWN ARROW 

Prior Sentence ALT+UP ARROW or 
CAPSLOCK+Y 

Next Paragraph CTRL+DOWN ARROW 

Prior Paragraph CTRL+UP ARROW or 
CAPSLOCK+CTRL+U 

Next Page CTRL+PAGE DOWN 

Prior Page CTRL+PAGE UP 

Page Down PAGE DOWN 

Page Up PAGE UP 

End of File CTRL+END 

Top of File CTRL+HOME 
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Help 
Description Keystroke 

Context Sensitive Help SHIFT+F1 

Help F1 

Keyboard Help INSERT+1 or CAPSLOCK+1 

Where Am I CTRL+SHIFT+F12 

Text Selection 
Description Keystroke 

Select Next Character (Edit 
Mode) 

SHIFT+RIGHT ARROW 

Select Prior Character (Edit 
Mode) 

SHIFT+LEFT ARROW 

Select Next Word CTRL+SHIFT+RIGHT 
ARROW, 
INSERT+SHIFT+RIGHT 
ARROW, or SHIFT+RIGHT 
ARROW in Read-only Mode 

Select Prior Word CTRL+SHIFT+LEFT ARROW, 
INSERT+SHIFT+LEFT 
ARROW, or SHIFT+LEFT 
ARROW in Read-only Mode 

Select Next Line SHIFT+DOWN ARROW 

Select Prior Line SHIFT+UP ARROW 

Select to End of Line SHIFT+END 

Select to Beginning of Line SHIFT+HOME 

Select Next Page SHIFT+PAGE DOWN 
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Description Keystroke 

Select Prior Page SHIFT+PAGE UP 

Select to Beginning of Page CTRL+SHIFT+HOME 

Select to End of Page CTRL+SHIFT+END 

Select All text on current 
page 

CTRL+A 

Say Selected Text CAPS LOCK+SHIFT+DOWN 
ARROW or 
CAPSLOCK+SHIFT+A 

Acquisition 
Description Keystroke 

Toggle Recognize Columns CTRL+SHIFT+Z 

Acquire F4 or SPACEBAR when

Mail Sorter Preview CTRL+SHIFT+F3 

Acquire and Replace Current 
Page 

CTRL+SHIFT+F4 

BuckScan money identifier CTRL+M 

Acquisition Context Menu APPLICATIONS Key 

Visual Settings 
Description Keystroke 

Cycle Between Views CTRL+SHIFT+V 

Font Background Color CTRL+5 

Font Size – Increase CTRL+4 

Font Size – Decrease CTRL+3 
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Description Keystroke 

Font Spacing – Increase CTRL+8 

Font Spacing – Decrease CTRL+7 

Font Type CTRL+6 

Toggle Two Tone CTRL+2 

Scroll Exact View Down ALT+CTRL+DOWN ARROW 

Scroll Exact View Left ALT+CTRL+LEFT ARROW 

Scroll Exact View Right ALT+CTRL+RIGHT ARROW 

Scroll Exact View Up ALT+CTRL+UP ARROW 

Pan Down Incrementally CTRL+WINDOWS 
Key+DOWN ARROW 

Pan Up Incrementally CTRL+WINDOWS Key+UP 
ARROW 

Pan Left Incrementally CTRL+WINDOWS Key+LEFT 
ARROW 

Pan Right Incrementally CTRL+WINDOWS 
Key+RIGHT ARROW 

Pan Up One Screen PAGE UP 

Pan DOWN One Screen PAGE DOWN 

Pan to Top Left WINDOWS Key+HOME 

Pan to Top RIGHT WINDOWS Key+PAGE UP 

Pan to Bottom Left WINDOWS Key+PAGE 
DOWN 

Pan to Bottom Right WINDOWS Key+END 
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Description Keystroke 

Pan Down Smoothly WINDOWS Key+DOWN 
ARROW 

Pan Up Smoothly WINDOWS Key+UP ARROW 

Pan Left Smoothly WINDOWS Key+LEFT 
ARROW 

Pan Right Smoothly WINDOWS Key+RIGHT 
ARROW 

Increase Smooth Panning 
Speed 

PLUS 

Decrease Smooth Panning 
Speed 

MINUS 

Increase Zoom Level CTRL+PLUS (press and hold 
to zoom continuously until you 
reach the desired zoom level) 

Decrease Zoom Level CTRL+MINUS (press and hold 
continuously until you reach 
the desired zoom level) 

Zoom to Page Width CTRL+SHIFT+W 

Zoom to Page Height CTRL+SHIFT+H 

Zoom to Default Zoom Level CTRL+SHIFT+D 

Rotate Image Right CTRL+SHIFT+R 

Rotate Image Left CTRL+SHIFT+L 

Toggle Camera Light CTRL+L 

OpenBook Feature Hotkeys 

Description Keystroke 
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Description Keystroke 

Insert Bookmark CTRL+F9 

Delete Bookmark CTRL+SHIFT+F9 

Insert Comment ALT+CTRL+M 

Delete Comment SHIFT+DELETE 

Edit Comment ALT+ENTER 

Say Comment ALT+SHIFT+APOSTROPHE 

Begin/end Highlight CTRL+F11 

Highlight Selected Text ALT+F11 

Cancel Highlight ESC 

Remove Highlight CTRL+SHIFT+F11 

Say Highlight ALT+CTRL+F11 

Toggle Highlight 
Announcement 

ALT+SHIFT+F11 

Next  Highlight F11 

Prior Highlight SHIFT+F11 

Copy to Clipboard CTRL+C 

Cut to Clipboard (Edit 
mode) 

CTRL+X 

Paste from Clipboard (Edit 
mode) 

CTRL+V 

Delete Current Page CTRL+DELETE 

Delete Character (Edit 
Mode) 

DELETE 



 37 

Description Keystroke 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle 

CTRL+E 

Move Page Down in page 
order 

ALT+PAGE DOWN 

Move Page Up in page 
order 

ALT+PAGE UP 

Insert Page Break (Edit 
Mode) 

CTRL+ENTER 

Delete Page Break (Edit 
Mode) 

CTRL+SHIFT+DELETE 

Find text CTRL+F 

Find next occurrence of text CTRL+SHIFT+F 

Replace text (Edit Mode) CTRL+H 

Spell Check F7 

Thesaurus CTRL+T 

Undo CTRL+Z 

Decrease Voice Rate ALT+CTRL+PAGE DOWN 

Increase Voice Rate ALT+CTRL+PAGE UP 

Mute Synthesizer CTRL+F5 

Close Document Window CTRL+F4 

Document Toggle CTRL+F6 

New File CTRL+N 

Open File CTRL+O 
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Description Keystroke 

Open Audio Directory CTRL+R 

Print CTRL+P 

Save Current Page CTRL+SHIFT+S 

Save Document CTRL+S 

Exit OpenBook ALT+F4 
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